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Abstract— Early detection of cracks in composite 

structures is essential to ensure structural safety, reliability, 

and service life, especially in aerospace, automotive, and civil 

engineering applications. Fiber reinforced composite (FRC) 

materials, while offering excellent strength-to-weight and 

stiffness-to-weight ratios, are vulnerable to damage 

mechanisms such as matrix cracking, fiber breakage, and 

delamination. These defects may initiate internally and 

remain undetected until catastrophic failure occurs. This 

paper presents a comprehensive vibration-based approach for 

crack detection in glass fiber reinforced composite cantilever 

beams using a combination of experimental modal analysis 

and finite element analysis (FEA). Changes in natural 

frequencies and mode shapes are employed as damage-

sensitive parameters for identifying crack presence, location, 

and severity. Experimental investigations are conducted using 

an FFT analyzer, impact hammer, and piezoelectric 

accelerometer, while numerical simulations are performed 

using ANSYS Workbench. The experimental and numerical 

results show good agreement, confirming that vibration-based 

techniques provide a reliable, economical, and non-destructive 

method for structural health monitoring of composite beam-

like structures.   
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I. INTRODUCTION 

Fiber reinforced composite materials have become 

indispensable in modern engineering due to their superior 

mechanical properties, corrosion resistance, and design 

flexibility. These materials are extensively used in 

aerospace components, automotive structures, wind turbine 

blades, marine applications, and civil infrastructure. 

Despite these advantages, composite structures are 

susceptible to various types of damage during 

manufacturing, handling, and service life. Common 

damage modes include matrix cracking, fiber fracture, 

delamination, and interfacial debonding. Among these, 

cracks play a critical role in reducing stiffness and load-

carrying capacity, often acting as initiation sites for further 

damage propagation. 

Traditional non-destructive testing (NDT) techniques 

such as ultrasonic testing, radiography, eddy current 

testing, magnetic particle inspection, and liquid penetrant 

testing are widely used for damage detection. Although 

effective, these techniques often require expensive 

equipment, skilled personnel, surface accessibility, and 

localized inspection. Moreover, many conventional NDT 

methods are time-consuming and not suitable for 

continuous structural monitoring. 

Vibration-based damage detection has emerged as an 

attractive alternative due to its global nature, simplicity, 

and cost-effectiveness. Structural damage alters stiffness, 

mass distribution, and damping characteristics, leading to 

measurable changes in dynamic properties such as natural 

frequencies, mode shapes, and frequency response 

functions. By monitoring these vibration parameters, it is 

possible to infer the presence and severity of damage. In 

composite beams, cracks introduce local flexibility, 

resulting in a reduction of natural frequencies and 

modification of mode shapes. 

This study focuses on vibration-based crack detection in 

glass fiber reinforced composite cantilever beams. A 

combined experimental and numerical approach is adopted 

to investigate the influence of crack parameters on dynamic 

behavior. Experimental modal analysis using FFT 

techniques is complemented by finite element modeling to 

validate the results and provide deeper insight into crack-

induced dynamic changes. 

II. LITERATURE REVIEW 

Over the past few decades, extensive research has been 

conducted on vibration-based damage detection in beam-

like structures. Early studies demonstrated that cracks 

significantly reduce stiffness, leading to measurable 

reductions in natural frequencies. Behera et al. investigated 

inclined edge cracks in cantilever beams and reported a 

systematic decrease in natural frequencies with increasing 

crack depth. Their work highlighted the sensitivity of mode 

shapes to crack location and inclination. 
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Kamble and Chavan employed wavelet transform 

techniques combined with experimental vibration data to 

identify crack parameters in cantilever beams. Their results 

showed high sensitivity to small cracks and demonstrated 

that higher vibration modes improve crack localization 

accuracy. Lakhdar et al. focused on damage detection in 

composite structures and emphasized that degradation of 

flexural rigidity directly affects modal parameters. Their 

experimental findings confirmed the effectiveness of 

vibration analysis for composite damage detection. 

Several researchers have also explored finite element 

modeling for crack simulation, often representing cracks as 

local reductions in stiffness or as rotational springs. While 

numerous studies address metallic beams, fewer 

investigations focus on composite beams with inclined 

cracks using combined FFT-based experimental techniques 

and numerical validation. The present work aims to address 

this gap by providing a detailed experimental–numerical 

study on crack detection in FRC cantilever beams. 

III. METHODOLOGY 

A. Specimen Preparation 

Glass fiber reinforced composite beams were fabricated 

using the hand lay-up technique, which is well-suited for 

laboratory-scale composite fabrication. E-glass chopped 

strand mat was used as the reinforcement material, and 

polyester resin served as the matrix. A wax-based release 

agent was applied to the mould surface prior to fabrication 

to prevent adhesion. 

The fabrication process involved alternate placement of 

fiber mat and resin layers until the desired thickness was 

achieved. Care was taken to ensure proper wetting of fibers 

and removal of entrapped air using manual compression. 

The laminate was allowed to cure at room temperature for 

48 hours. 

The final beam dimensions were: 

 Length: 800 mm 

 Width: 60 mm 

 Thickness: 6 mm 

After curing, inclined edge cracks of known depth and 

location were introduced using a diamond cutter. Crack 

parameters were carefully controlled to ensure 

repeatability. 

B. Experimental Modal Analysis 

The composite beam specimen was rigidly clamped at 

one end to form a cantilever configuration. An impact 

hammer was used to excite the beam, providing a 

broadband input force.  

A piezoelectric accelerometer was mounted near the 

crack location to measure the vibration response. 

The excitation force and acceleration response signals 

were fed into an FFT analyzer, which computed the 

frequency response functions (FRFs). From the FRFs, the 

natural frequencies corresponding to the first three bending 

modes were extracted. Multiple trials were conducted to 

ensure consistency and accuracy of the measurements. 

 

FIGURE I: SCHEMATIC DIAGRAM OF EXPERIMENTAL MODAL ANALYSIS 

SETUP. 

IV. FINITE ELEMENT ANALYSIS 

Finite Element Analysis (FEA) will be used in this 

project to analyze the vibration behaviour of composite 

beams under varying conditions. FEA will help predict the 

structural response and identify conditions that may lead to 

material failure. The analysis will be performed using 

ANSYS Workbench, where both 2D and 3D models can be 

evaluated. 

A. Proposed Modal Analysis 

Modal analysis will be carried out to determine the 

natural frequencies and mode shapes of the composite 

beam. This analysis is essential for understanding the 

dynamic characteristics of the structure and will also serve 

as the basis for further dynamic studies such as harmonic 

response or spectrum analysis. 

Purpose of Modal Analysis 

Modal analysis will be used to: 

 Determine the natural frequencies of the beam 

 Identify corresponding mode shapes 

 Study the effect of cracks on vibration behaviour 

 Support harmonic or transient dynamic analysis 

 Evaluate prestressed or rotating structures (if 

applicable) 

 Apply cyclic symmetry (when working with 

symmetric structures) 
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In ANSYS Workbench, modal analysis is performed as a 

linear analysis, where nonlinearities such as contact or 

plasticity are ignored, even if defined. 

Proposed Steps for Modal Analysis 

a) Startup 

The modal analysis will be initiated in ANSYS 

Workbench using the path: 

ANSYS → Workbench → Modal Analysis 

 
FIGURE II: STARTUP PATH 

b) Engineering Data 

Material properties of the composite beam will be 

defined under Engineering Data. A new material named E-

Glass Epoxy will be created and assigned as the default 

material. 

The proposed material properties are: 

TABLE I 

 MATERIAL PROPERTIES (PROPOSED) 

Property Value Unit 

Mass Density (ρ) 2000 kg/m³ 

Young’s Modulus 

(E) 

39×10

³ 

N/mm² 

Poisson’s Ratio (ν) 0.30 — 

c) Saving the Project 

The ANSYS Workbench file will be saved at a preferred 

location for further analysis. 

d) Geometry Preparation 

The geometry of the cantilever beam will be modelled in 

Creo Parametric 2.0. Beams with various crack will be 

generated. 

 depths 

 locations 

 inclinations 

The final CAD model will be exported in .igs format and 

imported into ANSYS Workbench. 

 

FIGURE III. MODEL HAVING CRACK IN CREO PARAMETRIC 

 
FIGURE IV: MAGNIFIED VIEW OF CRACK. 

e) Modal Setup in ANSYS 

Mesh Generation 

A fine mesh will be generated to increase the accuracy 

of results. 

Steps: 

Mesh → Mesh Settings → Fine Mesh 

Mesh → Right Click → Generate Mesh 

 

FIGURE V: MESH MODEL OF BEAM 
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Applying Boundary Conditions 

A fixed support will be applied at one end of the beam to 

create a cantilever configuration. 

Path: 

Select Surface → Insert → Support → Fixed Support 

Number of Modes 

For the study, three to four mode shapes will be 

extracted. 

Path: 

Analysis Settings → Number of Modes → 3 (or 4) 

f) Solution Phase 

After all inputs are defined, the simulation will be solved 

to obtain the natural frequencies and corresponding mode 

shapes. 

        

FIGURE VI: SOLUTION OF MODEL. 

V. RESULTS AND DISCUSSION 

A. Validation of Uncracked Beam Model 

The natural frequencies obtained experimentally for the 

uncracked beam were compared with finite element 

predictions to validate the numerical model. 

TABLE II 

 COMPARISON OF EXPERIMENTAL AND FEA NATURAL FREQUENCIES 

FOR UNCRACKED BEAM 

Mode FEA (Hz) Experimental (Hz) 

1 6.73 7.00 

2 42.15 43.85 

3 66.67 70.00 

The close agreement between experimental and 

numerical values confirms the accuracy of the finite 

element model. 

B. Effect of Crack Parameters 

The presence of a crack resulted in a noticeable 

reduction in natural frequencies for all vibration modes. As 

crack depth increased, stiffness degradation became more 

pronounced, leading to larger frequency reductions. When 

the crack location moved away from the fixed end toward 

the free end, the influence on bending stiffness decreased, 

resulting in relatively higher natural frequencies. 

TABLE III 

 NATURAL FREQUENCIES OF CRACKED BEAM (C = 0.25, E = 0.30) 

Mode FEA (Hz) Experimental (Hz) 

1 6.69 6.89 

2 42.16 43.85 

3 66.49 63.54 

The results demonstrate that vibration-based parameters 

are sensitive to crack presence and severity. Higher 

vibration modes showed increased sensitivity to crack 

location and inclination. 

VI. CONCLUSIONS 

This study presents a comprehensive experimental and 

numerical investigation of vibration-based crack detection 

in fiber reinforced composite cantilever beams. The results 

confirm that cracks introduce local flexibility, leading to 

measurable reductions in natural frequencies and 

modifications in mode shapes. Experimental modal 

analysis using FFT techniques, combined with finite 

element modeling, provides an effective and reliable non-

destructive evaluation approach. The close correlation 

between experimental and numerical results validates the 

proposed methodology. The findings of this work 

demonstrate the potential of vibration-based techniques for 

structural health monitoring of composite structures and 

can be extended to more complex geometries and real-time 

monitoring applications. 
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